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END USER LICENSE AGREEMENTS
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LICENSE
The software in this package is licensed to the end-user, not sold. Applied Photophysics grants a nontransferable license as follows:
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1 INTRODUCTION
The Pro-K (Pro-Kineticist) software is primarily intended for analysis of time dependent spectra generated by the
Applied Photophysics SX and LKS series of stopped-flow and laser flash spectrometers. These multivariate data
sets are most typically generated using the photodiode array (PDA) detector or Spectra-Kinetic mode of
operation.
Pro-K for PC is functionally similar to the same named product available for the Acorn RISC OS workstation
supplied with Applied Photophysics stopped-flow spectrometers since 1990.
This user guide covers a full description of the installation and use of the software in the analysis of time
dependent spectra.

1.1 Security
Pro-K is protected from unauthorised distribution by means of a unique license for every PC Pro-K is installed on.
This license is obtained by sending a license request file to tech support at APL. APL will then return a unique
license to the sender of the original request file. The license can then be uploaded to the Pro-K software and
activated.

1.2 System Requirements
Pro-K is a 32bit application designed to run on PCs or compatibles running Microsoft Windows. It is
recommended that a system of at least the following specification be used:







Pentium or compatible processor
128 MB RAM minimum
5 MB Hard disc space required during installation.
CD ROM for installation.
800x600 VGA or higher graphics resolution.
Windows 2000, ME, XP, Vista or 7.
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2 APPLICATION SUMMARY
Pro-K represents a major advance in the analysis capability available to scientists studying wavelength
dependent reaction kinetics or time dependant spectra. The introduction of instrumentation capable of generating
high quality sets of time dependent spectra comprising frequently many thousand individual absorbance (or
fluorescence) measurements has prompted the development of an analysis system which can exploit this data
fully and efficiently.
Pro-K allows the scientist to globally analyse the complete data set according to a proposed reaction scheme,
providing a best fit parameter set which will accommodate all kinetic behaviour across the entire measured
wavelength range.
The key feature of „global analysis‟ is the optimisation of non-linear reaction parameters (rates) at all measured
wavelengths simultaneously. Because individual rates contribute to each kinetic record to differing degrees over
the measured wavelength range (depending on the spectral distribution of the reaction intermediates), analysis
of all records globally reduces the correlation of these parameters, since events at all wavelengths contribute to
the least squares minimisation procedure. This results directly in a more robust fit and the reliable identification of
minor intermediates. In addition, the identification of unknown species is supported by the availability of their
calculated spectra.

2.1 Key numerical elements of Pro-K
2.1.1 Singular Value Decomposition (SVD) of Data Sets
SVD of the original data matrix yields unbiased information about the minimum complexity of the underlying
chemical system by providing a model free indication of the number of coloured, linearly independent
components present. In doing so it outputs a reduced representation of the data matrix as an ordered set of
basis spectra and corresponding time dependent amplitudes. Successive pairs of these vectors approximate the
independent components featuring in the original data in a least squares sense. Significantly only a subset of this
output therefore need be used for subsequent model analysis. This application of SVD as a data reduction
system is valuable in speeding up subsequent numerical calculations and substantially reduces the space
occupied by the original data set both in memory and on disc.
2.1.2 Global Optimisation of Reaction Parameters using the Marquardt-Levenberg Algorithm
Either the original data set or the SVD output may be analysed, exploiting the kinetic information at all
wavelengths simultaneously. Separation of the nonlinear (rates) and linear (amplitude) parameters is a crucial
element of the method, substantially reducing the parameter space allowing reliable convergence of the fitting
algorithm. Linear regression of best fit concentration profiles to the original data set yields the individual
component spectra.
2.1.3 Fitting Performed Directly to Reaction Models using Numerical Integration
Fitting is conducted directly to concentration profiles generated by numerical integration. This allows fitting to
arbitrary reaction mechanisms including simple decays and multi-step reactions including parallel reactions,
second order reactions, equilibria etc. Models are entered using a simple reaction scheme editor. The user
provides starting concentrations and rate estimates but has no need to refer to explicit rate equations or
formulae. On completion residual plots of kinetics and spectra at all wavelengths and times illustrate the global
accuracy of the selected model. To facilitate fitting of more complex schemes, which can possess more than a
single least squares solution, the analysis allows the introduction of fixed (i.e. known) spectra and the locking of
individual rate and equilibrium constants.
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2.1.4 Simulation
To supplement analysis Pro-K includes a comprehensive simulation capability allowing the synthesis of artificial
sets of time dependent spectra of arbitrary complexity. These data sets can then be analysed as a normal data
set using the facilities described above. This simulation capability is invaluable for learning the systems
capabilities, as well as providing an excellent tool for demonstrating and exploring the behaviour of spectrally
active reaction mechanisms.
2.1.5 References
1. Henry E.R., Hofrichter J. Singular Value Decomposition: Application to Analysis of Experimental Data.
Methods in Enzymology 1992 vol 210 p129 Academic Press.
2. Maeder M. Zuberbuhler A. Nonlinear Least-Squares Fitting of Multivariate Absorption Data. Anal Chem 1990
vol 62 p2220.
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3 INSTALLATION
Pro-K is supplied on a CD. The software will not function unless the license has been loaded after the initial
installation of the software. Details of how to install and load the unique license are listed below.

3.1 Installation Procedure
Insert the Pro-K software CD into the CD-Rom drive of your computer. The Pro-K installation program will start
automatically. If the CD fails to auto-run, run the SETUP.exe file from the main directory of the CD.

Figure 3.1: the Pro-Kineticist Setup installation panel

Simply follow the instructions in the installation program Setup Wizard. A license terms of agreement window will
be shown to which “I agree” must be selected so that the installation can continue.
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Figure 3.2: the Pro-Kineticist Setup License Agreement panel

A choice of the components of software which you would like to install are presented to you in the next window,
note that Pro-K and HP macro are selected by default.

Figure 3.3: the Pro-Kineticist Setup components panel

After selecting the components of software, an install destination must be assigned.
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Once installation is complete the user will be prompted whether they would like to open Pro-K and the attached
readme.txt file. Please note that any changes or late-breaking information will regarding the product will be found
in this file.
When Pro-K has loaded up for the first time (either via the Desktop shortcut, the start menu or from the previous
step) a dialog will be displayed informing the user that there is “No valid license found”.

Figure 3.4: the Pr-K licensing dialog box

To request a licence, click on the Create Request File button. The user will then be presented with a file dialog to
specify the name and location of the request file. Request files have the extension “.req”. A licence request is
generated and written to the specified file.
Send this file to Applied Photophysics (techsup@photophysics.com) who will return a licence file which will have
the same name but a different extension ".lnc".
Start Pro-K again to load the licence. In Windows XP the user must be an administrator to install a licence,
similarly in Windows Vista and Windows 7 the user is required to right click on the shortcut (or the entry in the
Start menu) and then select "Run as administrator". The dialog will again be displayed informing you that there is
no licence available.
The licence can be loaded into the program in two ways: it can be loaded from a file or it can be typed into the
edit box. To load the licence from a file click on the “Load from File” button and choose or specify the licence file
in the resulting file dialog. Entering the licence manually is tedious and error-prone so this method should only be
used if the file is unavailable for some reason.
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Please note that the licence only applies to the PC from which the request was made. If you need to run the
software on more than one PC please contact Applied Photophysics on 01372 386537.
It is suggested that the Display configuration available from the control panel is set to use small fonts to make
best use of the graphics work area.

3.2 Uninstall Procedure
The Pro-K application should only be uninstalled using the add/remove programs option in the control panel. This
will cleanly remove and deregister the application.
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4 PRO-KINETICIST USER CONTROL
4.1 Launching Pro-K
The Pro-K application is launched from the desktop by clicking on the icon below:

This will open the main application window show below. All functional operations are accessed from the
application menu bar as for any Windows conformant application. Many of these operations also have quick
toolbar shortcuts with distinctive icons to the top and left of the main window. All support tool tips - whereby a
brief prompt appears next to the mouse cursor when it lies over a particular toolbar or menu item. This prompt is
reproduced and sometimes embellished in the status bar prompt at the base of the window. The 3 toolbars can
be dragged and made free floating or docked elsewhere in the window if required.

Figure 4.1: the main application window
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4.2 Toolbar Structure and Function
4.2.1 The View Toolbar
The View toolbar comprises 14 icons provided to assist the user in the display and analysis of the current data
set:

Calculate singular value decomposition

Display singular value decomposition Eigen vectors

Display data in 3D wire-frame form

Display data in standard 3D form

Display data as kinetic traces

Display data as time dependant spectra

Display control dialog box

Display Analysis dialog box

Display calculated concentration profiles

Display calculated component spectra

Display Simulation dialog box

Cancel zoom

Edit comments

Create demonstration data set
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4.2.2 The Tools Toolbar
The Tools toolbar comprises 6 icons provided to assist the user in the common handling of data files:-

Open folder and load data

Save data

Print Preview

Print

Information about Pro-K

Help

4.2.3 The Mode Toolbar
The Mode toolbar comprises 3 icons provided to alter the display format of loaded data sets. The Residuals and
Calculated Curves icons are greyed out until analysis is completed:

Display original data

Display residuals

Display calculated curves
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4.3 Menu Structure and Function
4.3.1 The File Menu
New
Open
Save
Save As

Currently not used
Open file window for spectra-kinetic/svd/csv load
Save spectra-kinetic
Name and save spectra-kinetic

Export
→ SVD
→ Single kinetic
→ Single spectrum
→ Data (csv)
→ Fitted spectra (csv)
→ Conc profiles (csv)

Opens a sub-menu with various save options:
SVD file (spectra-kinetic)
Single kinetic record (single kinetic trace loader)
Single data spectrum (fixed spectrum loader)
Display configured data (start/stop/step) as csv
Fitted spectra in csv format
Concentration profiles in csv format

Import single sets
Print
Print preview
Print setup
Recent files...
Exit

Load point-by-point kinetics
Prints current on-screen display
Previews on-screen display in print format
Printer set-up control
Lists recently opened files
Exits the software

4.3.2 The Edit Menu
Copy

Copy on-screen image
(The Ctrl+C facility is not currently supported)

4.3.3 The View Menu
Tool bar
View bar
Mode bar

Standard toolbar on/off
Display type toolbar on/off
Data type toolbar on/off

4.3.4 The Data Menu
Demo
Offset time
Load Background
Data - Background
Data + Background

Synthesise quick 2 step demonstration data set
Input correction for zero-time of current data
Open file window for background spectrum load
Subtracts loaded background spectrum from data
Adds loaded background spectrum to data

4.3.5 The Graphics Menu
3D
2D Kinetic
2D Spectra
Wire frame
Control
Zoom off
Y Unit Label

Pseudo 3D display for data/residual/y-calc etc
2D time domain display of above
2D wavelength domain display of above
Wire-frame display control of above
Dialog box of options for each type of display
Cancels any prevailing zoom 2D displays only
Allows entry of annotation for Y axis.
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4.3.6 The Display Menu
Data
SVD basis
Residuals
Y-calc
Spectra
Conc profiles
Edit comments

Original experimental data
SVD output basis vectors and singular values
Fitted residuals
Fitted y-calc
Fitted spectra for current model
Concentration profiles for model or simulation
Edit two line comments for display and file

4.3.7 The SVD Menu
Calculate

Calculate SVD for data set

4.3.8 The Tools Menu
Simulation
Analysis

Display simulation dialog
Display analysis dialog

4.3.9 The Help Menu
Help Topics
About Pro-K

Not available in v1.0
Information about Pro-K software

4.4 Loading and Saving Data
File formats are all ASCII.
4.4.1 Loading Data using File-Open
The File-Open menu option is used to load Applied Photophysics Spectra-Kinetic data and SVD files of the same
format as those generated by the Acorn version of the Pro-K application. No notice of the file suffix (if present) is
taken since the file type is internally encoded.
It is also used to load CSV (or TSV) files as generated by spreadsheets or the CSV save options described
below. CSV files MUST have the .csv suffix in order to be recognised.
The CSV format requires the time dependent measurements (kinetic decays) to occupy the columns of the
spreadsheet matrix. Every spectral row must have a time index is its first entry. Any leading rows containing text
or " characters will be ignored. The first row containing numerical data delimited by either tabs or commas is
interpreted as follows: If the first character of the row is a number then the first column is treated as the time vector and successive
columns kinetic traces without wavelength encoding. The display will show a trace index on the "wavelength"
axis.
If the first character of this row is a delimiter (tab or comma) the loader will interpret the rest of the row as the
wavelengths vector for the time/kinetic matrix "below". Subsequent rows are then interpreted as above.
e.g.: (for clarity tabs have been used here and expanded to yield the fixed fields)
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Without wavelength:
"leading text rows ignored!"
T0
y11
y21
y31
y41
T1
y12
y22
y32
y42
T2
y13
y23
y33
y43
Etc
With wavelength:
"leading text rows ignored!"
w1
w2
w3
T0
y11
y21
y31
T1
y12
y22
y32
T2
y13
y23
y33

w4
y41
y42
y43

Etc
All values are treated as floating point.
The maximum number of rows (times) is 1024.
There is no limit on the number of columns within reason!
4.4.2 Loading Data using Import Single Sets
This option should be used to select and load single kinetic runs or multiple sets of kinetic runs collected using
an Applied Photophysics stopped-flow or laser flash photolysis spectrometer by the Spectra-Kinetic (or point-bypoint) method. The dialog allows multiple file selection by holding down the <CTRL> key on the keyboard whilst
selecting a set of files. Incompatible file types among the selected group will be ignored.
4.4.3 Saving Data using File-Save or File-Save As
The File-Save or File-Save As options are used to store the current data set in the APL Spectra-Kinetic format. If
a subset of the wavelength axis has been selected then only this subset will be saved. This enables the user to
remove data from the extremes of diode array data where the signal may be too noisy or may have been clipped.
All other save formats are reached from the Export sub-menu of the File menu.
4.4.4 Saving Data using the Export Option
The Export option of the File menu opens a sub-menu with the following six options for saving data:
SVD
Saves APL Spectra-Kinetic SVD files. The .svd suffix is appended to the filename.
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Single Kinetic
Saves an APL-ASCII format single kinetic run from the current data set compatible with the instrument control
software. This option is only available when the single trace option in the display control dialog is selected. The
.kin suffix is appended to the filename.
Single Spectrum
Saves an APL-ASCII format single spectrum from the current data set compatible with the instrument control
software. This option is only available when the single trace option in the display control dialog is selected. These
can be reloaded to fix spectra during fitting using the Analysis dialog box. The .spc suffix is appended to the
filename.
DATA CSV
Saves the current data set as a CSV file compatible with common 3rd party spreadsheets. The number of rows
and columns are determined by the display control dialog settings: Start, Stop and Step values in both
wavelength and time domains. This is a useful method of reducing excessively large data sets, for example
photodiode array generated data sets. The .csv suffix is appended to the filename.
Fitted Spectra CSV
Saves the best fit spectra as a CSV format file. The .csv suffix is appended to the filename.
Conc Profiles CSV
Saves the current concentration profiles derived from either simulation or fitting as a CSV format file. The .csv
suffix is appended to the filename.

4.5 Data Display
New data is initially displayed in 3D mode or one of the 2D modes if selected. Note that by default not all
measured spectra are displayed since this may obscure the kinetic features and also slows the screen redraw
time (see below).
Clicking on the View toolbar icons described in Section 5.3 provides the alternative available displays:
absorbance versus wavelength, absorbance versus time, and 3D wire-frame display.
Further control of the display can be achieved by opening the display dialog box on the View toolbar. This opens
a dialog box showing the current display settings. These depend on the selected display mode and are described
below.
4.5.1 3D Mode Control
The 3D Mode Control dialog box contains information on the total number of spectra or kinetic records in the
current data set. The Highlight area of the box allows the user to select the data display as either a set of time
dependant spectra or as a set of wavelength dependant kinetics. In addition, sets of editable text icons show
values indicating the subset of the data which is currently on display.
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Figure 4.2: the 3D mode control dialog box

In the example shown, the data comprises 200 spectra collected between 0 and 19.64 seconds. Note that of the
200 spectra, the default setting is such that only every 5th spectrum is displayed (for the reasons mentioned
above).
To change this distribution, the Start, Stop and Step icons may be edited as required. The Apply button
implements any changes made in the dialog box.
Note that when Spectra is selected, the data is presented as separate spectra. In this case Index refers to
spectra at different times. When Kinetics is selected, the data is shown as separate decays. In this case Index
refers to kinetic traces at different wavelengths. Experimentation will make these relationships clearer.
4.5.2 2D Kinetic Control
The 2D Kinetic Control dialog box provides control of data displayed as kinetic, traces (signal and time domains).
In addition, it is also possible to switch from displaying a group of kinetic traces to displaying them individually.
This is performed by selecting the Single icon button. Pressing the accompanying up and down arrows allows
the user to browse the individual traces.

Figure 4.3: the 2D kinetic control dialog box
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The Time Axis control determines whether the data is displayed with the points proportionally spaced (i.e. the
time axis is always linear) or with the points displayed evenly distributed (i.e. data acquired with a logarithmic
time-base will be displayed on a logarithmic time-base) as in the following example.

Figure 4.4: the 2D kinetic control dialog box with data traces

When viewing 2D kinetic traces, if Isometric is selected then data that has been collected on a non-linear timebase (using the split time-base or logarithmic time-base) will be displayed with all measurements at equal
intervals along the X-axis, rather than using their absolute time coordinate. This provides (visual) expansion of
the more highly time resolved portions of the decay.
Note that in the Single trace display mode, fitted curves (following analysis) are superimposed in red through the
individual black data curves. This provides the clearest facility for checking fit quality at all wavelengths and times
individually.

4.5.3 2D Spectra Control
The 2D Spectra Control dialog box provides control of data displayed as spectra (signal and wavelength
domains). The Spectra-Range controls allow the user to set the range and number of spectra displayed via the
Start, Stop and Step controls. The default display format in this mode is a group of overlaid spectra.
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Figure 4.5: the 2D spectra control dialog box

The Spectra-Single controls provide additional display options to enable the user to view individual spectra from
within the group. Ticking the Single option displays a single spectrum from within the group of spectra. Pressing
the accompanying up and down arrows allows the user to browse the individual traces.
Ticking the Position option provides a tool for determining the position of a single trace within a displayed group
of traces. With the Position option ticked, the current trace selected in the Single spectrum display panel is
highlighted against a grey display for the remainder of the group.
The examples overleaf show the three display formats available using the 2D Spectra Control dialog box.
The default display shows the group of overlaid spectra according to the Start, Stop and Set parameters entered
in the 2D Spectra Control dialog box:

Figure 4.6: the 2D spectra control with multiple traces displayed
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The Single option in the Spectra Control dialog box displays a single spectrum from the group of spectra. The
spectrum displayed is selected by pressing the accompanying up and down arrows to select the desired
spectrum:

Figure 4.7: 2D spectra control with single trace displayed

The Position option in the Spectra Control dialog box displays a single spectrum highlighted within the group of
spectra. The spectrum displayed is selected by pressing the accompanying up and down arrows to select the
desired spectrum.

Figure 4.8: 2D spectra control with single spectrum highlighted
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4.5.4 3D Wire Frame Display Control
The Wire Frame Mode Control dialog box provides control of the projection angle and fill of data displayed in the
3D wire-frame mode. The display may be viewed from various angles using the Turn and Tilt slider controls. The
display can either be filled or shown just in outline depending on whether Filled or Frame is selected.

Figure 4.9: the wire frame mode control dialog box

4.5.5 Other Display Features
Comments
Below the graphical display are a number of comment lines. The first two comprise the data file path and, in
single trace mode, an indication of the wavelength or time corresponding to the displayed trace.
Below these, up to two lines of comments can be added by selecting the Comment icon option on the View Bar.
These comments are automatically stored in the data files if saved to disc.
Zoom Function
2D displays can be zoomed up to enable viewing of areas of the display in more detail. Clicking the left mouse
button inside the display window produces a „rubber banding box‟ which can be dragged around the required
zoom area. The zoom can be cancelled by double clicking the left hand mouse button inside the display window,
or clicking on the Remove Zoom icon on the View Bar.
X-Y Coordinates
In any 2D data display window, the right hand mouse button will display the x and y coordinates of the cursor in
the box on the bottom right hand corner of the display window. This function also provides coordinates for the
calculated component spectra and calculated concentration profiles.

Figure 4.10: the X-Y coordinates display position
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4.6 Singular Value Decomposition
The singular value decomposition (SVD) algorithm is an integral feature of Pro-K.
When applied to a data matrix Y (Time x Wavelength) containing a set of time dependant spectra the result is a
set of output matrices comprising ordered sets of basis spectra and time dependent amplitudes, together with
corresponding weighting factors known as singular values.
The relationship of the input to output matrices is as follows:
Y = U.S.VT
The time dependent amplitudes are present in the column vectors of U whilst the basis spectra occupy the row
vectors of V. S is a diagonal matrix containing the singular values. It should be noted that within U there are
available as many time-dependent amplitude vectors as there are individual wavelengths defining the number of
columns in Y.
The important feature of the decomposition is that only a subset of the paired vectors, together with their
corresponding singular value (which acts as a weighting term), need be used to reconstruct the features of Y
when Y contains measurements on systems comprising only relatively few (with respect to the number of
wavelengths) independent components. In other words multiplying together only the first N vector pairs and
singular values will provide the best N component reconstruction of the data matrix Y in a least squares sense.
Increasing N beyond the number of underlying components will cause vectors to be included which reconstitute
nothing but noise present in the original data.
This separation brought about by SVD of the data into its underlying linearly independent components provides
the basis for its usefulness in Pro-K analysis and data compression.
4.6.1 Component Prediction
Once SVD has been performed it is possible to inspect both the output vectors and the singular values. The first
eight vector pairs may be displayed in the main display screen with time dependent amplitudes (actually premultiplied by their corresponding singular value) next to basis spectra. The singular values are listed next to each
pair of Eigenvectors. Typically, the singular values will fall from the first and largest value down (through
intermediate values) to a minimum threshold which plateaus out (e.g. 3.4, 0.8, .25, .0011, 0010, .0010, .0010...).
The number of significant singular values (SSV) can be used as a model-free indication of the number of linearly
independent components present in the original data.
In a chemical system these linearly independent components reflect the contribution of independent absorbing
species. The plateau amplitude is representative of the background noise level. The SSVs have corresponding
spectral and time vectors displayed graphically. It should be clear that only the vectors corresponding to the
SSVs contain significant features which will be reflected in the reconstructed data.
In the example opposite, both the vector pairs and the singular values suggest that there are 4 linearly
independent components (spectrally distinguishable absorbing species).
4.6.2 Effect on Analysis
All the time dependent information inherent in the original data is contained in the significant time dependent
amplitude vectors from matrix U. This can be used to considerably improve the performance of the global
analysis since only these vectors (pre-multiplied by their corresponding weighting singular value) rather than
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every original kinetic curve, need be globally fitted to obtain the optimised rates for a reaction model. Since there
are typically far fewer significant time dependent amplitude vectors than measured wavelengths this both speeds
up the minimisation process and reduces the number of amplitude parameters that need to be calculated at each
step. Once the minimisation phase is completed the resulting best fit concentration decays need only be fitted to
the original data once to calculate the corresponding amplitudes for the original data matrix, yielding the
individual component spectra.
4.6.3 Noise Reduction
Once SVD has been performed, the data displayed will be reconstituted data from the first eight vector pairs and,
in general, this will be indistinguishable from the original data. However, following SVD, the user can opt to
reconstitute the data using less than (the default) eight vector pairs. This enables those vectors contributing only
random noise elements to be removed from the data and hence the data will appear smoother.
When displaying the SVD vectors, the SVD Control dialog box can be displayed by clicking on the Control Dialog
icon in the ViewToolbar:

Figure 4.11: the SVD control dialog box

This dialog box can be edited to reconstitute the data using less than eight vector pairs. Selecting a lower
number will remove those vectors pairs of least significance e.g. if 6 is selected, the 7th and 8th vector pairs will
not be included in the reconstitution when Calculate is selected. Following reconstitution the displayed data will
be modified to reflect the number of vector pairs selected.
In order to use the reconstituted data set for subsequent data analysis, the reconstituted SVD set must be saved
and reloaded. If this operation is not performed, data analysis will continue to be performed on the 8 vector pair
SVD set irrespective of the number of vector pairs that has been used to constitute the data being displayed.
When reconstituting an SVD data set, care must be taken not to discard vector pairs that may be contributing
significant information to the data. If in any doubt, do not discard the vector pair.
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Figure 4.12: the SVD basis vectors
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4.7 Data Reduction and Analysis
Pro-K provides a unique model fitting capability. The key feature of the analysis is the Global fitting of the entire
data set to a supplied chemical reaction scheme. The reaction scheme and fitting parameters are entered via the
Analysis dialog box. This function is accessed from the Analysis icon on the View toolbar.

Figure 4.13: the Analysis dialog box

Typically the data set to be analysed will have been reduced by SVD but this is not a requirement. Using the
SVD result has a speed advantage for larger data sets since a subset of the output comprising the significant
time dependent amplitudes is fitted rather than all the kinetic records at every measured wavelength (see section
5.6 for a description of the SVD reduction technique). By default 8 time vectors are fitted from the SVD output,
therefore use of SVD reduced data for analysis is of benefit when the number of measured wavelengths exceeds
this number. It should be emphasised that the result of the fit will not be affected either way.
The rest of this section describes the necessary steps required to fit a model to the data.
4.7.1 Model Entry
The top left of the Analysis dialog box contains a model entry box. To initiate entry click the left mouse button on
the top line. A text caret will appear allowing normal typing and editing operations. Pressing <Return> or the
down arrow will move text entry to the next line.
A reaction scheme is entered in terms of its reactants and products with forward and reverse conversions
represented by the forward and reverse arrows respectively. The reaction model to be fitted must be broken
down into lines each defining a single reaction step. For a two-step consecutive scheme the following would be
entered
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A>B
B>C
A second order equilibrium would appear thus:
A+B<>C
Up to seven separate steps are currently allowed. Mixed stoichiometries are allowed by prefixing the number to
the relevant species (e.g. 3A+B>2C).
Note that a stoichiometry greater than 2 i.e. as in 3A+B->C is not interpreted as reactions of corresponding order
greater than 2 (i.e. NOT dC/dt=k1[A]3[B] fourth order). Instead the number is used to multiply the rate of loss.
This is useful for simulating a cascade of reactions which removes relatively large amounts of a reactant from
circulation i.e. where a rate limiting step is followed by several fast steps consuming the same reactant. Without
this feature, the above stoichiometry would require the following explicit form:
A+B->C+W
A+W->X
A+X->Z

slow
fast
fast

Note: the second order scheme 2A->B is interpreted as normal i.e. dB/dt=k1[A]2. However, take care with 2A+B>C since this will be interpreted as 3rd order i.e. dC/dt= k1[A]2[B]. To avoid this enter 8A+4B->4C to push all
stoichiometries over 2 and multiply the fitted rate by 4.
It is not currently possible to have the same species name appearing more than once on a line. These are
limitations in the current reaction scheme translator which will be resolved in future releases.
A+A>B
A>B+A

/Error/
/Error/

Note however 2A>B is ok here
It is permissible to use multi-letter names for individual species but if species on either side of a step contain
common letters then it is necessary to surround the names with [ ] brackets e.g.
[E]+[S]>[ES]
[ES]>[EP]
[EP]>[E]+[P]
Stoichiometries should precede the opening bracket (e.g. 2[ES]).
It is recommended that whenever possible unique single letter species names are used to prevent the risk of
misinterpretation.
For the enzyme mechanism above use
E+S>B
B>C
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C>E+P
4.7.2 Compilation
Once the model has been entered press the Compile icon to the right of the model entry box. This causes
translation of the scheme into a form understood by the program. At the same time the lower section of the
dialog box is set up for parameter initialisation. Each species name is listed with a corresponding text insertion
icon for its starting concentration. Similarly each rate specified in the scheme is listed with an index number
corresponding to the step. Forward and reverse rates are distinguished using positive and negative indices
respectively. For the model a+b<>c>d the rates would be listed k1, k-1 and k2. An estimate must be provided for
each rate in the scheme in the corresponding text insertion icons prior to fitting as shown in the figure below
(where a 3-step consecutive model has been entered i.e. a>b>c>d).

Figure 4.14: the compile button

4.7.3 Parameter Initialization
During fitting the starting concentrations and rates are used to generate intermediate concentration profiles
according to the reaction model. These are then fitted to the original data in a linear regression step. This
provides the overall residual, which is the quantity iteratively minimised by the analysis. The fitting process
involves optimisation of the rates by non-linear least squares such that the calculated concentration profiles yield
the 'best fit' to the current data set. It is necessary to provide starting concentrations for all species in the
compiled scheme as well as estimates of all listed rates. The accuracy required of the rate estimates is largely
dependent on the complexity of the scheme being modelled. These rates are then optimised by the global fitting
algorithm. The initial concentrations provide the starting values for the numerical integration routines, and enable
the subsequent calculation of true intermediate spectra.
It is important that non-zero concentration values are provided for the reactant species.
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To enter values for a particular parameter click the mouse on the appropriate entry box. The cursor keys can be
used to move between them.
-1

-1 -1

Note: No visual distinction is made in the rate list between first (units: s ) or second order (M s ) rates since no
units are displayed. If however the model contains a second order step then the corresponding rate for the
-1 -1
combination is implicitly second order and should be supplied with a true second order estimate (units M s ).
4.7.4 Fixing Spectra and Parameters
These two facilities are provided to constrain the fitting process. In some circumstances they are a requirement
while in others they simply aid convergence.
Locking Rates:
To lock a rate, simply click on its adjacent lock icon.
Fixed Spectra:
Two options for 'fixing' spectra are provided. Known spectra for a species can be loaded from file or where
appropriate a 'colourless' option selected.
In both cases the species in question should be selected by clicking on the circular icon adjacent to its name (this
will deselect any other).
To load a previously scanned spectrum, press the right hand mouse button whilst the mouse pointer is inside the
analysis window, click on Load Fixed Spectrum. This will open the directory viewer to locate the spectrum file of
the known spectrum. This will have been collected using the scanning facility in the instrument control software
or by using a photodiode array detector. This could also be a saved single data spectrum with the same
wavelength resolution as the data set to be analysed.
It is necessary that the scan file be labelled with the species concentration in the cell at the time of the scan. This
is used by Pro-K to translate the scan into an array of molar extinction coefficients for each measured
wavelength. This will normally have been done using a text editor and must be done prior to loading into Pro-K.
Important: The concentration must first be multiplied by the ratio of cell pathlengths (Lspectra/Lscan) if they
differ.
The value is inserted below the final pair of points in the scan file followed by <Return>. Any additional file
information beyond this value should be removed.
Example: If the spectrum for a species X was taken with 10μM X in the observation cell and the time dependent
spectra set are collected after initiating a reaction of X with Y in the cell with the same pathlength then 10e-6
should be added to the X spectrum file. If however the cell pathlength is changed from 1cm to 0.2cm between
scan and spectra set 10e-6 x 1/0.2 = 50e-6 should be added to the file.
If no concentration term is found at the end of a scan file a value of 1.0 is used by default.
To load the scan for the selected intermediate simply highlight the file and click on Open.
The letter in the Fix column for the selected species will change from a U to an F indicating that the fixed
spectrum has been loaded.
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To unlock the spectrum, simply click on the F which will revert to a U indicating that the spectrum is unlocked.
In the case where an intermediate is known to be colourless over the measured wavelength range, click the right
mouse button over the analysis window and select Set Colourless.
4.7.5 Choosing the Fit Range
It is possible to restrict the analysis to a portion of the loaded data by altering the X Start and X Stop values.
These values determine the time range over which the analysis is to be performed. The values are entered as a
time, in seconds.
It is common to move the X Start value from zero, so as to remove noise at the beginning of stopped-flow traces
from the data to be fitted.
4.7.6 Minimisation
Once the model has been compiled and the starting parameters supplied (together with any fixed spectra) rate
optimisation is initiated by clicking the Fit to Model icon. During minimisation the mouse pointer is replaced by an
hourglass 'busy' icon.
A non-linear Marquardt-Levenberg algorithm is used which iteratively attempts to improve the non-linear
parameters (rates) to minimise the sum of the squares of the residuals of a theoretical data set calculated from
those parameters and the real observed data, (termed the SqSum). To allow for differing numbers of points per
trace this value is converted into a Variance, the variance being defined as the SqSum divided by the (number of
points minus the number of fit parameters). The iteration number is updated in the display together with the
current Variance. In addition, the current Marquardt factor is displayed. This is an internal weighting parameter
used by the algorithm to modify its technique of minimisation. In difficult cases it will be seen to increase by
factors of ten at a time then decrease as a valid least squares minimum is approached. The final step of a
successful minimisation is always conducted with a Marquardt factor of zero, since this yields the correct
standard errors for each fitted parameter.
If convergence is not achieved, the minimisation stops when the number of iterations reaches the value set in the
Iterations box. This value can be changed by the user. The number of iterations performed must be checked to
ensure that proper convergence has indeed been achieved rather than the iteration limit being reached (this is
often indicated by a non-zero Marquardt factor). This is most easily ensured by accepting completion only when
total iterations number less than the number set in the box.
To halt the minimisation process after the current iteration press <CTRL> once.
When fitting is complete, the optimised rates are listed together with their standard errors. There are a number of
display options for the fitted data.
4.7.7 Data Display
Following completion of the data fitting process, it is possible to view the Y-calc (the modelled best fit data set),
residual, calculated Spectra and Concentration profile displays (by choosing the appropriate icon on the View
and Mode toolbars).
Any display can be printed by selecting the Print icon on the toolbar. Printouts are accompanied by a listing of
the fitted model and optimised reaction parameters.
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Fitted kinetic curves: Single wavelength kinetic traces (black) are displayed with overlaid modelled traces (red)
via the 2D Kinetic Control dialog box and selecting the Single option. The fitted rates and model details are
automatically appended below the traces following minimisation.

Figure 4.15: 2D spectra control with fitted curves

Single residual traces: The residual is the difference between the data trace and the modelled trace. This is
commonly used to show the quality of fit for a single wavelength. A single residual is displayed using the
Residuals icon on the Mode toolbar for a single kinetic trace.

Figure 4.16: a single residual trace
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Overlaid residual traces: A group of residuals is displayed using the Residuals icon on the Mode toolbar for a
group of kinetic traces. The overall flatness of the residual is an indicator of the overall quality of fit for the model
to the data set.

Figure 4.17: overlaid residual traces

3D Overlaid residual traces: The 3D wire-frame display provides a clearer display of a group of residual traces.

Figure 4.18: 3D overlaid residual traces

Calculated spectra: The calculated spectra of the modelled reaction components are displayed by clicking on
the Calculated Spectra icon on the View toolbar.
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Figure 4.19: calculated spectra

Concentration profile: The concentration profile of the modelled reaction components as a function of time are
displayed by clicking on the Concentration Profile icon on the View toolbar.

Figure 4.20: concentration profiles

Y-Calc data set: The calculated data set is displayed by clicking on the 3D Wire-frame icon on the Mode toolbar.
Below is the 3D wire-frame display.
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Figure 4.21: calculated data set

4.7.8 Algorithm Errors
Occasionally an error will occur within the algorithm signified by nonsensical parameters. The two most common
causes of this are:
1. A reactant concentration has been accidentally left at zero.
2. A model has been incorrectly entered which translates into an impossible set of equations for integration.
4.7.9 Convergence Problems
It is important to appreciate that convergence is not necessarily guaranteed. Minimisation to a unique set of
parameters requires either that changing a parameter affects the overall residual and that the effect of changing
one parameter on the residual is not compensated by a change in another.
The minimisation procedure can, and should be, repeated with alternative models as required (starting with the
simplest), by repeating the cycle of model entry, parameter initialisation and minimisation. In particular, with more
complex schemes, the identification of a satisfactory model may take several attempts and stepwise refinement.
In some cases there may not be sufficient information in the data to successfully fit to an elaborate model even
though there is other evidence for it. This situation can for example occur when the observed spectral changes
accompany only slow events in a proposed mechanism, but fast events such as ligand binding equilibria are
known to precede them. To include the fast part of the mechanism (unless its rates are fixed) in the fitting may
well cause problems, since it is poorly characterised.
Wherever possible always start with a simple model and build on a successful fit. Look for areas where the
residuals are poor and consider adding an appropriate step to account for the behaviour. Where possible, fix
rates and spectra in order to constrain the fit. In many cases this will enable convergence which previously was
impossible.
4.7.10 Model Validity
Convergence of a fit indicates that a least square minimum for that model to the data has been found. The most
informative gauge to the quality of fit is the residual plot (available from the icon in the main display window). Any
systematic deviations (as opposed to random noise) apparent here indicate that either a genuine spectral event
has been missed (or not accounted for), or that an instrumental artefact is corrupting the data. The contribution of
the latter should be minimal or of an obvious form (spikes or other abrupt deviations).
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The example below shows a group of overlaid kinetic residual traces following minimisation to an incorrect
reaction model. The non-random and systematic variation of these curves indicates that the model is
inappropriate for the data.

Figure 4.22: overlaid kinetics traces for an incorrect reaction model

The second assessment of fit validity can be made by inspecting the calculated spectra. If a model is satisfactory
in terms of the residual plots then it must be accompanied by calculated spectra which make chemical sense in
terms of shape and sign. An incorrect model may well produce reasonable residuals but bizarre or negative
extinction spectra.
This can also arise, even with a correct model, when calculated rates are assigned to individual steps in the
wrong order: try modelling the system: A>B>C with rates 10s-1 and 1s-1. Also, remember that as schemes
become more complex the first mechanism which fits the data well may not be unique. This has to be judged on
the basis of knowledge of the chemistry and evidence from other experiments and conditions.
The example below shows a bizarre negative extinction spectrum for component B. In this case the fitted rates
for k1 and k2 have been assigned incorrectly (transposed). As this is still a mathematically correct solution, the
error would not be apparent from inspection of the fitted data and residual curves alone.
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Figure 4.23: overlaid traces with k1 and k2 transposed

4.7.11 Constraining the Fit - Locking Rates and Fixing Spectra
It is not possible to describe every situation where either a fixed rate or spectrum will be needed but the following
illustrate two examples:
Data Model: A+B>C or A+B<>C
The spectrum of either A or B must be supplied (unless one is colourless – see below). This is because there are
an infinite number of solutions for the spectra of A and B calculated by linear regression. This will prevent fit
convergence unless one or other is supplied.
Data Model A<>B
By itself this is an unrealistic model, but illustrates the general problem of separating individual rates from
equilibria. In this case the data can be fitted with the model A>B since the transition occurs with an observed
monotonic rate kobs = k1+ k-1. The fit to A>B will converge yielding k obs and good residuals but produce incorrect
spectra. Attempting to fit to the model A<>B will produce an arbitrary solution (note the fit will converge) for k1
and k-1 though in all cases they will add up to the constant and unique k obs. This system can only be solved by
fixing correctly one or other of the two rate constants.
Both these examples illustrate the problem that arises when there are too many variable parameters free to
account for the observed data. The only way to obtain the unique and correct solution is to apply appropriate
constraints by either supplying fixed spectra or locking rates.
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4.7.12 Stiff Option
A “stiff” fitting algorithm is used automatically by the software when required. This algorithm is invoked for models
when widely differing rates of concentration change are detected. It is not anticipated that the user will be
required to turn this option on manually.
4.7.13 Fit Spectra
The Spectra icon can be selected at any time when a compiled model and parameter set is present. It simply
carries out a linear regression fit of the concentration profiles defined by the current model and displayed rates
(from the estimate column) to the current data set. This is the same as the final step that takes place
automatically after minimisation and yields the best-fit extinction spectra and residual plots etc. The difference is
that the currently displayed rate or concentration values are used, i.e. there is no requirement that the rates are
the best-fit values. Therefore it is possible to modify these parameters e.g. swap the order of rates, adjust a rate
up or down etc, and see the effect on the subsequent residuals and spectra.
4.7.14 Saving Models and Fits
The current model can be saved by clicking the right hand mouse button with the mouse pointer anywhere over
the analysis window (except the model entry box) and selecting Save Model from the menu.
If this option is chosen a save dialog box will appear allowing the user to enter a filename and save the model in
a selected folder.
This file contains details of the currently entered model and can be loaded back into the analysis window anytime
that model is required by using the Load Model option underneath Save Model.
If the data has already been analysed then the saved model file will also contain the concentration values and
the fitted rate constants for the reaction currently under investigation.

4.8 Simulation
In addition to the global analysis facilities, Pro-K provides an extremely powerful data simulation facility. This
allows the creation of artificial sets of time dependent spectra (including added noise) for experimentation and
analysis. These are synthesised according to reaction models and spectral characteristics provided by the user.
The data can then be analysed as if it had been collected during an experiment.
The Simulation window is accessed via the corresponding icon on the View toolbar. It bears several similarities
to the analysis dialog box, the major difference being the array of input icons for setting up the spectral
characteristics of the individual species.
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Figure 4.24: the Simulation dialog box

This tool is invaluable for learning the behaviour of the data analysis facilities with respect to different data sets of
varying complexity. For example, if a data set is synthesised according to a particular model does that mean it
can be fitted directly to the same model without locking rates or spectra? It also allows the user to get a feel for
how chemical mechanisms behave and account for observed spectral characteristics (e.g. isosbestic points).
The first step for simulation is model entry. This is carried out in the same way as described for analysis (section
5.7).
Once complete, select the Compile option to translate the scheme and set up the dialog box for individual
parameter entry.
For any simulation it is possible to define the required number of spectra and the number of kinetic traces
(number of wavelengths) in the entry icons provided. This determines the overall number of absorption
measurements synthesised. The default settings are No of spectra=100 and No of Wavelengths=60. This will
simulate data with 100 absorption values per kinetic run at each of 60 wavelengths (6000 values in all). Note that
the 'wavelength' range starts from 1 and runs to the number of wavelengths chosen (i.e. the displayed
wavelength for synthetic data sets merely represents an index rather than a realistic wavelength).
It is also necessary to enter the desired time course (in seconds) of the simulation which will of course depend
on the rates of the model to be simulated. Absorption values will be synthesized at intervals of (Time/No of
Spectra) seconds. If required you can also simulate Gaussian noise by entering a number in the noise box.
The desired starting concentrations and rates can now be entered alongside their labels (below the model entry
box).
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The select icons are not currently used.
Remember to provide finite concentrations for all reactants.
It is then necessary to type in values for spectra calculation. Each spectrum (for each species) has one Gaussian
peak, characterised by its peak Position, its Width and its Height.
Position: a floating point value between 1 and Lambda (max).
Width: a floating-point value chosen according to the total number of wavelengths. This provides the spread of
each peak. The smaller the value (minimum 1), the narrower the peak width. For a simulation with 60
wavelengths a Width value of 5 will produce sensible individual spectra.
Height: any floating-point number. This will be the relative peak height for each component. 1.0 is good value to
start with!
To set up a colourless species, type in 0 (zero) for its height parameter. Its peak position and width parameters
will be ignored.
Having set up and compiled the model and entered all the parameters press Simulate. After a few seconds the
synthesized data will be displayed in the main window. Any data previously loaded or simulated will be
discarded. If an error is displayed this will almost certainly be due to incorrect parameter entry, which can easily
be corrected.
Once the simulated data has been displayed proceed with SVD or analysis exactly as if this were a real data set
loaded from file.
Note that if the Analysis dialog is chosen while the Simulation dialog is on display, the latter will be automatically
closed and vice-versa. In addition, the model plus concentration and rate parameters, used for the simulation will
automatically be transferred to the analysis dialog. Finally, it should be noted that, concentration profiles are
available without having performed a fit.
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